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Genève, le 5 février 2023

Zorro du Zodiac
007 Picadilly Street 
GB-7007 Londre
Londre
Angleterre

Chère  <Nom>,
Voici plusieurs pages de tests de publipostage, avec quelques informations sur la manière de faire.

Pour supprimer une base de données liée à un document .odt :

Outils > Options... > Bases de données
On sélectionne la base de données, puis on clique sur le bouton « Supprimer »
On peut répéter l’action.

Pour ajouter une base de données pour faire du publipostage :  

La méthode de la page suivante est bien meilleure, car elle pose moins de problèmes.

Outils > Options > Bases de données
On clique sur le bouton « Nouveau », puis « Parcourir », on efface le filtre « Base de données ODF », 
on sélectionne le fichier .odt contenant les champs que l’on désire utiliser dans le document. On 
termine en cliquant sur le bouton « Ouvrir ».
Voir l’image ci-dessus.

<Titre> <Prenom> <Nom>
<Adresse>
<Sigle>-<Num_post> <Ville>
<Region>
<Pays>
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Pour ajouter une base de données pour faire du publipostage, autre manière de faire :

Insertion > Champ > Autres Champs... Ctrl+F2

Cliquez sur le bouton « Parcourir » qui suit le texte « Ajouter un fichier de base de données »
Sélectionnez le fichier .ods qui contient les champs utiles au publipostage.
La base de données apparaîtra, comme dans l’image suivante.

Il est fortement conseillé de donner un nom court au fichier .ods, par exemple : ADR.ods.
De même, donner un nom court à la feuille du tableur, par exemple une seule lettre :  F.
Cela aura l’avantage de simplifier l’affichage et l’insertion de champs.

Lorsque l’on ajoute une base de données ainsi, il y a un lien entre le fichier .ods et le fichier 
LibreOffice Write (.odt) qui contient le texte de publipostage, mais la base de données est copiée dans 
le fichier .odt  à l’ouverture du fichier .odt.
Donc parfois, il faut sauver, fermer le fichier .odt, puis l’ouvrir à nouveau.
Par exemple, si vous voulez changer des données dans le fichier .ods contenant les données de la base, 
il est conseillé de :
° Sauver et fermer le fichier .odt
° Ouvrir et éditer le fichier .ods
° Le sauver et le fermer
° Ouvrir le fichier .odt, dans ce cas, la base de données sera mise à jour pour le publipostage.

Si le nom de la base de données a changé, le lien est perdu. Il faut redéfinir tous les champs dans le 
document .odt. 
Une explication de la raison est donnée en page suivante.
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Avec « Affichage > Noms des champs Ctrl+F9 », vous voyez les noms des champs au complet, ce qui 
donne de l’information.
Par exemple, dans l’image suivante, on voit que l’on a utilisé deux bases de données différentes pour 
définir les champs. Il faut ÉVITER cela si on ne désire pas d’ennuis supplémentaires.
Il n’est pas possible d’ouvrir deux bases de données, donc il faudra redéfinir certains champs et ouvrir 
la base de données avec le bon nom.
Souvent, il est bon de sauver le document, le fermer puis l’ouvrir à nouveau.
Si les champs ne fonctionnent plus, parfois il est bon d’effacer la base de données, puis d’ajouter une 
base de données comme expliqué ci-dessus, puis de redéfinir chaque champ.
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Pour insérer un champ de publipostage :

Insertion > Champ > Autres Champs... Ctrl+F2
Il faut avoir « Ajouter un fichier de base de données ».

On sélectionne « Champ de publipostage », 
on ouvre la liste des champs en cliquant sur la flèche « > » qui précède le nom de la base de données
on clique sur le champ désiré
on clique sur le bouton « Insérer ».
On peut aussi double cliquer sur le champ désiré pour l’insérer.
À tout moment, on peut faire des modifications dans le texte, par exemple pour ajouter un espace ou 
un saut de ligne.

De nombreux problèmes peuvent apparaître. Certains sont traités ci-dessous.

On veut également améliorer certaine présentation, par exemple :
° On veut supprimer les pages blanches qui sont insérées automatiquement
° On veut des numéros de pages qui se suivent, pas uniquement des numéros impairs
° On veut rétablir le lien avec la base de données
° On veut éliminer les lignes correspondantes à des champs vide
° On veut afficher un texte différemment suivant la valeur d’un champ
° On veut afficher un texte conditionnel suivant si le champ est vide ou nom
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Chez moi, par défaut, il y avait des pages blanches après chaque page.

Pour corriger ce défaut, faire :
Fichier > Paramétrage de l’imprimante...

Options...

Il faut décocher sous « Autre » la case « Imprimer les pages blanches insérées automatiquement »
Puis cliquer sur le bouton OK.
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Autre problème lors de l’impression, toutes les pages sont impaires :

Pour régler ce problème : Format > Style de page...

Dans « Paramètres de mise en page », 
« Mise en page » sélectionner « Droite et gauche ».
« Numéros de page : »  1, 2, 3...
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Le lien est rompu entre le document texte et la base de données.

Cela peut se produire notamment si vous changez le nom de la base de donnée ou si vous la déplacez.

Vous vous en rendrez compte lorsque, dans le document texte, vous n'arrivez plus à naviguer entre les 
différents destinataires avec les flèches de la barre d'outils Mailing.

Comme indiqué plus haut, il faut éviter de changer le nom du fichier (.ods) contenant les données.
Pour tenter de corriger l’erreur ci-dessus :
° Effacer toutes les bases de données : 
     « Outils > Option... > LibreOffice Base > Bases de données > sélectionner et supprimer »
° Sauver et quitter le fichier .odt
° Ouvrir le fichier .odt
° Afficher la source de données : « Affichage > Sources de données Ctrl°Maj°F4 »
° S’il y a encore une source de données, effacer à nouveau les bases de données.
° Sélectionner un champ, le premier par exemple
° Insertion > Champs > Autres champs... Ctrl+F2 > Parcourir et insérer la base de données .ods
° Sélectionner dans la liste le champ correspondant à celui du texte (le premier par exemple)
° L’insérer, puis fermer.
Avec un peu de chance, les champs fonctionneront de nouveau.
Sinon, il faut tous les redéfinir.
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Pour éliminer des lignes vides, typiquement dans l’adresse :

Pour cela, on indiquera de masquer le paragraphe contenant la ligne vide de la manière suivante :
° Insertion > Champs > Autres champs... Ctrl+F2 > Fonctions > Paragraphe masqué
° Sous condition, taper le nom du champ concerné suivit de eq "", par exemple
     Institution eq ""
  Cela indiquera que si le champ est vide (égale un champ vide ""), alors le paragraphe sera masqué.

Insertion > Champs > Autres champs... Ctrl+F2 > Fonctions > Paragraphe masqué

Si on double clique sur un champ correspondant à un paragraphe masqué, visible avec 
Affichage > Nom des champs Ctrl+F9
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On veut afficher un texte différemment suivant la valeur d’un champ

Typiquement, en début de lettre on a :
- Chère Madame ...   ou
- Cher Monsieur
Pour faire cela, on utilise la fonction : « Texte conditionnel ».  Faire :

° Insertion > Champs > Autres champs... Ctrl+F2 > Fonctions > Texte conditionnel
° Sous « Condition » écrire : « Titre eq "Madame" »
° Sous « Alors » écrire : « Chère »
° Sous « Sinon » écrire : « Cher »

Si le Titre est « Madame », la lettre débutera par « Chère », si le titre est « Monsieur » ou vide ou 
n’importe quoi de différent de « Madame », la lettre débutera par « Cher ».
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On veut afficher un texte conditionnel suivant si le champ est vide ou nom

Par exemple, dans le début de lettre de cette page, on peut vouloir écrire :
« Cher Monsieur Nom » si le Titre est non vide, par contre, si le Titre est vide on veut écrire :
« Cher Prénom Nom ».

Pour ce faire, on utilise de nouveau la fonction : « Texte conditionnel ».  Faire :

° Insertion > Champs > Autres champs... Ctrl+F2 > Fonctions > Texte conditionnel
° Sous « Condition » écrire : « [ADR.F.Titre] »
° Sous « Alors » écrire : «ADR.F.Titre»
° Sous « Sinon » écrire : « ADR.F.Prenom »

Si l’Affichage de la « Sources de données Ctrl+Maj+F4 » est activé, on peut faire des 
« cliquer-glisser » des noms des champs depuis la source des données vers les entrées : « Condition », 
« Alors » et « Sinon ».

Quelques références :
https://blog.liberetonordi.com/index.php?post/libreoffice-publipostage
https://www.mediaforma.com/libreoffice-writer-publipostage/

Voici des liens d’aides de LibreOffice Writer :
https://help.libreoffice.org/latest/fr/text/swriter/main0000.html  Aide générale

Ce deuxième lien concerne des textes conditionnels.
https://help.libreoffice.org/latest/fr/text/swriter//01/04090200.html?
&DbPAR=WRITER&System=UNIX
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Génération d’étiquettes à partir d’une base de données sous forme de tableur .ods

Partir avec un fichier LibreOffice Calc, avec le même contenu que précédemment : « ADR.ods ». 

En bas de la fenêtre, faire un clique droit sur l’onglet nommant la feuille, puis « Renommer la feuille »,
pour lui donner un nom court, typiquement une seule lettre.

Lancer LibreOffice Writer. Menu Fichier > Nouveau > Étiquettes
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Dans la boîte de dialogue, cliquer sur l’onglet « Format » et insérer le format des étiquettes et de la 
page. Dans l’exemple de l’image ci-dessous, il y a 3 colonnes, 8 lignes, chaque colonne fait 7 cm de 
large et l’espace entre les bords gauches des étiquettes est également de 7 cm. Les dimensions de la 
page, 21 cm x 29.7 mm sont ceux d’une page A4.

Cliquer sur l’onglet « Étiquettes ».
Effacer tout le texte qui s’y trouve.
Si la bonne base de données est disponible, on peut déjà introduire des champs, mais des champs 
peuvent également être introduits plus tard.

Cliquer sur le bouton « Nouveau document ».
Une liste de « cases » des étiquettes est généré.
L’image montre les « cases » générées, vides.
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Si une base de données existe et que ce n’est pas celle désirée ou en cas de doute, effacer le lien au 
document, comme expliqué en page 1.

° Introduire les champs comme expliqué dans les pages précédentes :
   «  Insertion > Champ > Autres champs... Ctrl+F2 »
° Lier une base de données si nécessaire, comme expliqué précédemment.
°Avec « Affichage > Noms des champs Ctrl+F9 »
   on peut alterner l’affichage complet du nom des champs ou un affichage partiel.
° Un affichage partiel peut être utile, pour mettre en forme le texte de l’étiquette.

° Des textes conditionnels peuvent être ajoutés.
° Les lignes vides seront supprimée automatiquement.
° Pour l’instant les adresses se répéterons dans une même page.
° Pour changer d’adresse d’une étiquette à la suivante, placer le curseur en fin d’étiquette puis :

«  Insertion > Champ > Autres champs... Ctrl+F2 »
Sélectionner l’onglet « Base de données », puis « Enregistrement suivant » « Insérer ».

° Si on ne voit rien, changer d’affichage avec : « Affichage > Noms des champs Ctrl+F9 »
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° Pour des étiquettes petites, il se peut que l’on ne voit pas tout le texte. Dans ce cas, sélectionner tout 
le texte avec « Ctrl+A » et changer la police en 8 pt. Le refaire une deuxième fois, pour tout changer.

° Sélectionner tout le contenu de la case (Ctrl+A), Format > Paragraphe... > Retraits et espacement > 
Avant le texte : 0.5 cm, pour que le texte ne soit pas collé à gauche de l’étiquette.

° Sélectionner tout le contenu de la case (Ctrl+A), copier (Ctrl+C) et coller dans deux ou trois cellules 
voisines (Ctrl+A , Ctrl+V).
Le Ctrl+A sert à tout sélectionner, pour le remplacer par le texte que l’on désire coller.

° Tester en faisant un publipostage. 
Si les étiquettes ne sont pas comme désirées, revenir sur les points précédents.

° Sélectionner tout le contenu de la case (Ctrl+A), changer la taille de la police à 12 pt, ou ce qui est 
désiré, copier (Ctrl+C).

° Sur chaque case de la feuille, faire  (Ctrl+A , Ctrl+V).
° Tester une dernière fois. De nouveau, revenir aux points précédents, si nécessaire.

Attention lors de la génération d'étiquettes, la dernière étiquette de la page NE doit PAS contenir

l'instruction "Enregristrement suivant:ADR.F", car lors d'un saut de page, le passage à 
l'enregistrement suivant se fait automatiquement.

Références :
https://help.libreoffice.org/6.2/fr/text/shared/guide/labels.html
https://help.libreoffice.org/6.2/fr/text/shared/guide/labels_database.html


